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1. Slide transition
2. Slide Animation

3.  Animation preview
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Finishing step

1 Change order

2 Print note
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Insert: Tables, Illustrations, Links, Text, Media Clips
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Slide Show: Start Slide Show, Setup, Monitor
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View: Presentation Views, Show/Hide, Zoom, Color/Grayscale, Window, Macros
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d @QMS Office Button = New=> Templates — Create

Fiscal Year 2005 Annual Report
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W 2004 2005 © Average . . .
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Click to add notes
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CLICK TO ADD TITLE
Click to add subtitle

07/01/59 pp2007 15
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New Presentation

Templates

Fnk and recent q

Installed Templates

nstalled Themes
My templates..,

MNew from existing..,

Microsoft Office Online

Featured
Agendas
Award certificates
Calendars
Content slides
Design slides
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Greeting cards
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Plans
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)
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[2]

Blank and recent

Blank
Presentation
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Aa

Concourse Pitchbook

Blank Presentation
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. Save
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Handout Master & Note Master

Handout
Master
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Setup Orientation ~ Orientation~ Page~
Page Setup Placeholders

Slides Per | ] Footer V| Page Number | Themes
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E Fonts ~

[O] Effects -

Edit Theme

@ Background Styles =

D Hide Background Graphics
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Master View
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110:53

22



R A A AN

B

Note Master

RS
Motes Master | Home Insert Review Wiew
@ |¥| Header |?| Date D n Colors =
& E E Fonts =

. ¥ SlideImage V| Body
Page Motes Page Slide Themes

Setup Orientation ~ Orientation~ | ¥ Footer |¥'| Page Number - [O]effects -
Page Setup Placeholders Edit Theme

@ EBackground Styles =

()]
O]

|:| Hide Background Graphics

F}

Background

f4DEEI

Click to edit Master title style

* Click to edit Master text styles

Click to edit Master text styles
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Third level
Fourth level
Fifth level
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N13LAadNNEANIIAIDNEI Text Direction

N139AN1331N39 shape fill, shape outline, shape effect
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Shape fill

® shape fill fnuad 31U nia Wuraslnuzdne

@ Select shape >> home>> shape fill
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® table, Picture, clip art,
® shapes, smart art, chart
® Text box, word art, symbol, object
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® links

07/01/59 pp2007 36



Insert table:

Insert>> table>> LRaNIUIU TaIANI19>> N Enter

Table

Tables — Ellal
|| L] B E
Table

Picture Clip Photo  Shi
At Album -

: Insert Table
o Q

Table tool { 2 NANFFIAD OOO0OoOoOoO0OoOdd
abie 100 g Ooooooooon
*Design Ooooooooog
Ooooooooon

ol v 0000000000
you O00ooooonn
Ooooooooog
Oooooooooo

j Insert Table...
j Draw Table
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Insert SmartArt

o~

Insert>>

[« V] 1 = v
>> ﬂimmaaua:gmmu Layout @130Q8IN1T
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Choose a SmartArt Graphic

SmartArt A RS (At a 6 v
SmartArt >> Lean SmartArt Graphic Naa3nN17>> Wuwaanule Text pane

P @B RG]

all

List

Process
Cyde
Hierarchy
Relationship
Matrix

Pyramid

[

Basic Block List

Use to show non-sequential or grouped
blocks of information. Maximizes both
haorizontal and vertical display space for
shapes.

L QK J [ Cancel

]
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Process
Cyde
Hierarchy
Relationship
Matrix

Pyramid

|- o

A
Basic Block List
Use to show non-seguential or grouped
blocks of information. Maximizes both
horizontal and vertical display space for
shapes.

v

martArt Graphic

Dg) 9~ OE- )+
)

Home Insert Design
[:5] Add Bullet « Promote
: Right to Left | & Demote
Add
Shape = & Layout ] Text Pane

Create Graphic

07/01/59

pp204100-thai - Microsoft PowerPoint
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Slide Show

V E A

Layouts

pp2007

Review

View

SmartArt Tools

Design Format

&
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B oA

= List
% Process
Z;,f Cycle

sin  Hierarchy
Relationship

7 Matrix

. Pyramid

L=

AV E A

Basic Pyramid

Use to show proportional,
interconnected, or hierarchical
relationships with the largest component
on the bottom and narrowing up. Level 1
text appears in the pyramid segments
and Level 2 text appears in shapes
alongside each segment.

SmartArt Styles

“AALAAAAA
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i=] Add Bullet A Promote ou
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Design, layout, format
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9
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* save as template A8 NMIUUNNTIIALENDANLD 14 bW A NNUBYA

® switch row/column ﬁamsaé’u*’ﬁayjmzmwLLmLLazmsﬁﬂ

* select data ﬁaﬂ'mﬁaﬂ‘*ﬁ'aﬁayjamﬂms’m excel

* Edit data A ﬂ’hﬁLLﬂ“’lﬂJf’ﬁ’ayjaMmﬂa excel

* Quick layout @8 MIasusduuuvesmIalnaglusduuuauud
ﬂ”al,ﬂum{@ﬂﬁzmmﬁwag
: A A & & G 5 PR i @

® Quick style AaNTLRANF WARVBITITA LTUNTTNAUAT B30 WURR
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Y o A 6 A o % A
Layout 1°ﬁﬂ']1ﬁ%@°ﬁﬂ°ﬂ€lﬂ°ﬁﬁ|§@] DALLAW X,Y ﬂW%%@Lﬂ"UTQHﬂ NITLLFAIATINT B €

(Da)\d9- 053 )+ pp204100-thai - Microsoft PowerPoint Chart Tools
YLl
Home Insert Design Animations slide Show Review View Design Layout Format

Series “tue” - Y = ; & ; ! [

| d [ A ol Ma] oo ] B ] 6] ] @ ] () L2 o) ] |
@/Fnrmatﬂelectmn
- Picture Shapes Text Chart  Axis Legend Data Data Axes  Gridlines || Plot  Chat Chat  3-D Trendline Lines Up/Down  Error
&1 Reset to Match Style *  Box || Titlew Titles= =  Labels~ Table~ - v Area~ Wall~ Floor= Rotation - Bars~ Bars+

Current Selection Insert Labels Axes Background Analysis

Format ldinuaztuuy Wunas aaanss & Land kol uaz aug

I-’ﬁs; H9-05 )¢ Pp204100-thai - Microsoft PowerPoint Chart Tools
. Home Insert Design Animations Slide Show Review View Design Layout Farmat
S . L Dashaperine A v || L Bringto Front = |2 Align 550 -
{3?, Format Selection @ @ {@ [Abc J [Abc J ‘ Abe J |Lch - E Shape Qutline = _ AP J_J Send to Back Tﬁ Group +_—| :
&H Reset to Match Style \ T L) Shape Effects » &, Selection Pane ) Rotate = | *2* 2B o
Current Selection Shape Styles P WordArt Styles Arrange Size f
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student num

12

10

Student report

10

room1 room2 rooma3 room4

Room number

[] mon
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Insert Tab

@\,ﬂ_,q.-. v s Presentationl - Microsoft PowerPoint

~BRD P ’g, e E 4 BEOew
;

Table  Picture Clip SmartArt Chart  Hyperink Action  Tedt Header WordAtt Date Slide Symbol Object
» Art B Box~ &Footer - & Time Number
Tables Uinks A

Insert text with text box

- Q8N text box >> aAINNIAU >> NUNTRANYIWATOU
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Text

Text
Box

4

WaordArt

-

2

Symbol

Drawing tool 15U3Uuas Text, Word art waz Symbol

and Object

- Add text

click text box>> drawing text box>> typing letter

Add weord art
Click word art >> select type>>typing letter

Add symbol

Click Symbol>>select symbol>> insert

A Text Fill -

Text Effects »

la

,-’t-!:-, H9-08 )7 pp204100-thai - Microsoft PowerPaint Drawing Toals
e
Home Insert Design Animations Slide Show Review View Format

NANEOO - 2 i shape - & shape Fil

ﬂ, T —|_, ED G (e [,qb.; ] [,q};.cJ [Ahc} o D_} Shape Qutline = jﬂ": A / - ﬂText Outline -

43N ) oy 5 Eredbo % () Shape Effedts * AL~

Insert shapes Shape Styles Fi WordArt Styles
07/01/59 pp2007

3 Bring to Front = |2 Align -

ﬂ Send to Back - E Group

E{}Selectiun Pane Gl Rotate~ || *

Arrange

L -
3| 152
189"

Size

50
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Add Object

Click Object>> sel¢4] bject >> ok

Object

*Format picture 1TUTUUAITULLLE ANUANTA N1IIAALNTWVEY object
% = 1 @ 1 6 1 =4 dl | dqj
= daalimsladag 1w JUumwlualadieudsazdinginiasiien

,'{‘:D?g;\\l d9-03 )+ pp204100-thai - Microsoft PowerPoint Ficture Toals
i End

__-/ Home Insert Design Animations Slide Show Review View | Format

% Brightness = 1& Compress Pictures [y Picture Shape * | Ty Bringto Front = [Z Align = | []']

| (e —| ¥ £ S i = 3| Height: 219"
(D Contrast+ B Change Picture il d .‘ ‘ d E « [ Picture Border ~ || 4 Sendto Back *  [F] Group

- Crop = width: |5.29°
O Recolor~ g Reset icture 7 @ Picture Effects * || B Selection Pane 5 Rotate * s idth: 3,29

Adjust Picture Styles i Arrange Size
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Text and Object

*n135ld Header and Footer (WILazyng Uadx 1aa)

5

Date
& Time

Text

Slide
Mumber

Header
& Footer

07/01/59

Header and/ Eooter

Slide

Mokes and Hanu:ln:uuts]

[2]%]

Include on slide

(®) Update automatically

25/09/52 v

Language: Calendar tvpe:

Thai s | | Thai Buddhisk

I Fixed

25/09/52

apply ko Al

Apply

Zancel

Prewism

{| Slide number
> |Footer

[ ] Don't show on title slide

pp2007
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Links

Hyperlink  (mya3nsaaLton e ludaduniladng )

® Hyperlink create link to web page, picture ,e-mail or power point program

[ Lo lUgIntintiuine  Ladldgs sumw Ludu

Action ( MIfruanINIEaNRaNENAUnIIIRIAY )

® Action add the action to the object selected what will be happen when click

mouse over it.

1 A A Q/ tg/ A o 6 A Y o o 2
LD 3JLﬁﬂ\c]LW@G@GT%LN@%’]LﬁJ’]ﬁ’]’]ﬂuugﬂﬂqwc}’]v[@lﬂ']%%@ﬂ’]iﬂﬁztﬂqvlﬂ
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Hyperlink

@ Select object>>insert>>hyperlink>>select link to>> ok

Insert Hyperlink

Link, ko

Q)
Existing File or

Hyperlink web Page

Link Place in This
Dacurnent

Creake Mew
Document

E-mail Address

Texk bo display: |Hyperlink,

| | ScreenTip...

Select a place in this document:

Slide prewiew:;

47,
43,
49,

al.
a3,
3.
a4,
a5,
a6,
ar.

Slide Transitions
Slide Transitions
Slide Transitions

. Slide Animation

Animation Prewview
& Formatting Slide mast
9 Finishing step
Change arder
Make noke
Make noke
Make noke

[

54

| —— ._--""-f

Slide Animation
= Shdc Amamation

T e el 0

* T apply e ecmstton cSxe

v ST the T

PR T ATSSIARA S TR A e RN

v Clicik CuancTa AnImaNTeon

v Clicik Add Efecs CLET
+ Choos T ISR T =

84

] [ Cancel
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Action links

@ Selectobject>>insert>>action>>select action

Action Settings

on CIiCk>> Ok Maouse Click, |r'-'1|:|use el

Ackion on click,

{:} Mone

| |

=
=
i
i=
i
.

| First Slide v

{:!' Run prograrm:

| Browse, ..

Run macra:

Obiject action:

A [ ]Play sound:

0 | |

Highlight click.

Ok, l [ Cancel ]
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5 NMAANINUR 8@ (design)

® Page Setup
@ Slide Orientation

® Theme

@ Background
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Page Setup& Slide Orientation
D -Click Page setup>>

Page P
Setup bapeSetip

£l

Slides sized For:

on-screen Show (4:3)

Mumber slides From:

L d

2

Crienkation
Slides

A () Partrait

(%) Landscape

Motes, handouks & outline

(%) Portrait

() Landscape

o

Slide size, Orientation>> OK

07/01/59 pp2007

o

IS
N

5lide mm=
rientation =

=__I Portrait

— Landscape
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- Theme Background (suuuvvesaiua’laq)

Q

sert Design Animations Slide Show Review  View Format

i Calars =
ﬂp r-‘T-’"m- . E : Fonts'
[ [ []]] NEEEEN ENEEEN “ [ [ 1] ]]] ([ []]] =
v |O|Effets i ;
3-ims Acrobat

Themes
| EEEL

i Aa = | Builtdn
= = REERRE Office
CONNNEREN Grayscsle
DENEEN ipe
EEEEREE Aspec
NENNEN i
EREEEE concouse
REREEREN Equiy
HEERREN Fiow
BEEEERE Foundy
INNEEEN Median
REEREN Hetro
DNNEEN Module
EEEEEE Opulent
|| | [ R
RECCNN Origin
ROCEEN Paper
MEONERN soltice
INENNEN Technic
ERRREN Tk
RERERNE Uhban
NEEREN e

Create Hew Theme Calors...

07/01/59 pp2007 2

® Theme

® Design>> select theme

® To apply new colors to a theme:

® Click the Colors drop down arrow

® Choose a color set or click Create New Theme

Colors

-
[R—
=
f-----------



Q/

Background (FWWUBI& bae )

Background

Design>> Background styles

P

@_i'j Background 5tyles =
rmat B
Hide Background Graphics »

_lzl‘
_lzlv

Background ]
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6 NMITNF bae (Slide show)

@ Slide Show Options

1
1 o [« > [+ 5

° avalwuny ribbon ANaNAFILTUFAIRLAS AITh

q

® Start slide show

® Set up

® monitors
|@HE N-B 7 Presentations - Microsoft PowerPoint Drawin
_ Homé Insert Design Anmmations Slide Show Review View Developer Add-Ing Adrabat [ Fan

! r — . .
@ '@' @- L@ HE.. .3 Record Narration @l Resolution: Use Current Resolution
F Fro Cust I Lo L :
Famm il a
Beginning Current Slide | Slide Show=  Shide Show Shde ¥ Use Rehearsed Timings

| Start Slide Show 1 Set Up
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Start slide show

® from beginningNILRAIR bARLININ

6
R LaaLLIn
® from current slide NMIULFAIF bAALIY

mﬂa"laﬁﬂm;u”u

® Custom slide show
Gd‘ VX% o A
® LRAILANIZH RN LATUNIIAALREN
LY Theh
o "3"Eﬁﬁﬁ1ﬁ’§°’l°ﬁﬁavla@1‘%mmmuu,am

Iz IR1 0 UFY

07/01/59 pp2007
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-—7- C
ORI =
From Fram Custom

Slide Show -

Beginning Current Slide
Start Slide Show



Custom slide show

® 3371311 custom slide

® Slide show>> custom slide show>>custom show>>

® New>>enter slide show name >>select slide presentation to the slide >>add>>

ok>>close

=

= N
Custom ‘
Slide Show
E Custom Shows.., £

07/01/59

Custom Shows

Custorn shows:

Close

Define Custom Show:

Slide show name: | outline

Slides in presentation:

1, PowerPoint 2007
2, DUTLINE

3, OUTLINE

4, OUTLINE

5. 1 wanmahalas
£, wanAsalas

7. wanmahalae

8. 2 Getting start (Hame)
9, Screen layaut

10, Screen Layouk
11, Screen Layaouk

pp2007

12, Sereen Layauk

Slides in cuskom show:

1. PowerPaint 2007
2, QUTLIME
3, QUTLIME
4. CUTLINE +
+
oK ]l Cancel ]

62




Custom slide show

® N131d custom slide

® Slide show>> custom slide show >> select slide show name

aoutline

Custom Shows...
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Set up

The set up command contains many options for the slide show. These

options include:
® Hide slide ﬁaﬂﬁssﬁauavlaﬁﬁLﬁaﬂvlaﬂﬁuamlmgwa\ﬂlao full screen
® Set Up Slide Show (advance)

® Monitors AN§IN15IANTITHI1Da (advance)

07/01/59 pp2007
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e

Hide slide

@ Select slide you want to hide >> slide show >> hide slide

® To unhide click hide slide again
- =——

s s e H I d S8 | I d =
* Hide slide

¢ Hide current slide from the presentation.

' ¢ It will not be show on the full screen.
Note: &laglafisanliazdiaTasnany Upngat
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1 v
(- o

o C’i U tﬁl U 6 1 C’i o 1
FNRINAIFIIAIN LN AR LA LEAIATNAINTIRBA LT
di 6 [ ~N
AILROUR LAA D6 LN G
dl v A 6
msmaua"l,a@ﬁml;qpﬁmzl MIARNLNIE
MILEAIF LARTIAAE 9AT9 (looping)
msuunnaea W lualas (Narration options)

NNTAAGI%IN8 (Monitor resolutions)

07/01/59 pp2007
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7 MIYNATWLARAW LA (Animations)

@ Slide Transitions
@ Slide Animation

® Animation Preview
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Slide Transitions

® Slide Transitions Aam ¥ AR lacLafaw LRIV UM TIU RO UR Lag

® n1391 Slide transition
® LRaNRLaGNADINTIYN slide transition
® Click the Animations tab

® Choose the appropriate animation or click the Transition dialog box

Animations Slide Show Review View Developer Add-Ins Acrobat

:&, Transition Sound: | [Mo Sound] <

‘ H ;’;‘ J u__,ﬁ“ - JTranmtmnSpeed Fast -

Transition to This 5lide
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Slide Transitions

A -
@ MIILWNLRYI>> clicking the arrow next to .

Transition Sound

- El_“—fl_ Transition Speed:

o < A & = 430 Apply Ta Al
® ﬂ’]'iﬂ?%%@]ﬂ’ﬂ&llﬁ’ﬁmmzl,ﬂﬂEI%NVLQ@‘I>> T
clicking the arrow next to Transition
Speed
Add-Ins Acrobat
th, Transition Sound: Breeze =
E;ifl_ Transition Speed: | Fast =
13l Apply Ta All Slowr
sition to This Slide PMedium

Fast

07/01/59 pp2007

b Transition Sound: Breeze =] Al il

[Ma Sound]
[Stop Previous Sound]
Applause
Arrovy

Bomb

Breeze
Camera

Cash Reqgister
Chime

Click

Cain

Crum Raoll
Explosion

Hammear
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Slide Transitions

To apply the transition to all slides:

® Click the Apply to All button on the Animations tab

Animations Shide Show Fleviewy Wy Developer Sadd-Ims aScrobat Format

Yip Transition Sound:  [Mo Sownd]

- | | ‘] Ll == =] 1H Transition Speed: Fast -
J J J.‘ _I J_I __:il = .L_.j.:.ﬂ.:lj,Tn;l"‘_

Transition to This Slide

To select how to advance a slide:
Advance Slide

® Choose to Advance on Mouse Click, or Y| On Mouse Click

: Automatically After:  00:00
® Automatically after a set number of seconds

07/01/59 pp2007 70
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Slide Animation

Slide Animation
MIMnuAaNLabALAY (effects) 1R IANUE lad K38 10E NN

To apply an animation effect:

® Select the object

® Click the Animations tab on the Ribbon

o CIle Custom Animation Home It O | Ammlow | ShdeShow  Reier  Viw  Oedopr Ao Aoot Foml
: ] e o it [— . . Tt Sound: Erere v | Adionce Side
o CIle Add Effect pr— ‘ ﬂ -‘_ ﬂ i « 1 Tuntion Spesd: Pt * | ¥ Onhlouse Click
e {_ e e e s [P T Aoty Afer 019
. . ANIMaR NG Tramsdtion to This Slide I
Choose the appropriate effect = —
=
& e b
% bmhus

ﬁ Eit ]

dr Matisnpiths b

Salct a0 gement of the i, then
ok Stk et ol anivalen
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Animation Preview

® Animation Preview

To preview the animation on a slide:

@ Click the Preview button on the Animations tab

&)

I}H#-u)=

Home Insert Design

1

: Mo Animation -
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8 Formatting Slide master

E
- Flide kMaster Edet Master Imsert Arimmal

i Deieta

I 1 —l s A Rename —I W
® To change slide layout or design. tosert Shse Inaert imsert

Layout = Flacehalkder

@ View (ribbon) | Presentation Views (chunk) | Slide
Master to open master view.
A &

® {1 Slide Master ﬁatﬂ%ﬁhﬁﬁmuqmﬂ&ﬁﬁ's%mm

- A o
laan Layout NeadnNIa.

1 2 6 {
® &7 Slide layout mIuANIANIZE laaNAFLRUVAA

layout N1

{ & o
® {atdan Layout aan1i1n13 Edit slide 1
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9 Finishing step

® Change order

® Make note (print what)
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Change order

A 9 : : P v o @ &
ﬂamﬂmwwawaa Slide sorted view LWNBYINNNIIARIGUUDIR LA G
laan1Iang bas b19836Ln N e adInN1g

CUTLINE Animation & Slide show

i + Slgecs 1md Az
* Zemin e i
EPETE——

Screen Laﬂ(::lut“ Screen Layout Screen Layout

e L=

i T
ot

=T eiT = ETUng an T v ETUng an
Getting Start View slide t=xtand Object text and Object text and Object
+ Sxde Bareug cmed s 5 2md Romras oomasiOigacs
Add e deide - e g T . —— P
e o

L i an Mot s o, P B o
T2l B i A T kg s S
"

T FAGH Mo g e e
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Make note

'ﬁamsﬁuﬁﬂuwmimUluywwaomaa
Normal view li&1u8a4 Click to add
note
* 991 Slide show ;jﬁwz"l,ajl,ﬁuuw
YT

‘3/ 1 di = y
*UNUTILN YT LRAIG DL DN NNT Print

LU Notes page LYiNibih

07/01/59 pp2007

Make note ,

0
|
|
|
|
|
|
|
|
|
|
|
|
0
|
|
|
|
|
|
|
|
|
|
|
|

* Make note sty fiwamaas Click toadd note
e

(lickto add notes
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Make note

s _J d

* Print what #{lEana3at8anuuL wier
Blamme: % Hp Color LaserJet 26000

A s'vL vo X
NMITNUN LA~ W Status:  Idle Find Printer. ..
HP Color Laser Jet 26000

Tvpe:
: here: 4,28,
» SI Ide I:':Mgmment: ron e I:l Prink o FIl_E
Prink range Copies
v H an d ou tS =) Al (O Current: slide Number of copies:
1
®* Notes page O sides:
Enter slide numbers andfar slide ranges. For example,
. Outllne b [#] Collate
Aa 6 ; Y Print what: Handouks
*NIAUNLUL Slide 32 }e 1 e
Slides
2 ! 3 andouts L=l
WINNIzAN 861 F a6 Nores Pages
& 2 Outline Yiew: [ ]5cale ta fit paper
*N1INUN Handout 81d130LRanN 1- CFreme sices [IHich guaity

0 §lagda 1 niNIzaM C o (o
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Make note

* MINNNUUL Notes page 934 S—
V) ) QUTLINE
NN TUSAIANATN n

= c‘if c:; =2 1
s AN INERAINANI6

=
FRAN
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